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This is a description of my method for creating interactive 3D block diagrams with
Google SketchUp, which | developed from March 2010 through June 2011.

To illustrate the details of the method, | used the Bedrock Geologic map and cross-
sections of the Rochester, Vermont, Quadrangle published by Greg Walsh and Christine Falta in
2001. | chose this map because Greg Walsh used it as one of two examples in his excellent

paper:

Walsh, G.J., 2009, A method for creating a three dimensional model from published
geologic maps and cross sections: U.S. Geological Survey Open-File Report 2009-1229, 16 p.
available at http://pubs.usgs.gov/of/2009/1229/

Greg’s paper describes how to drape a geologic map on the topographic surface in
Google Earth and use Google SketchUp to position cross-sections in their correct position within
the geologic map. This allows the user to view that part of a cross-section which is above the
topographic surface together with the geologic map in a 3-D context. Steve Whitmeyer from
James Madison University has created a wonderful tool that makes positioning a cross-section
in Google Earth straightforward.
http://csmres.jmu.edu/Geollab/Whitmeyer/web/visuals/GoogleEarth/tools/XS.html

This guide shows how to make a 3-D block diagram with Google SketchUp that
integrates a geologic map with cross-sections below the topographic surface. This approach
requires the ability to make segments of the map invisible in order to see the cross-section. The
image below shows what the finished model looks like:
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If you discover ways to improve the method described here please email me
(pkarabin@williams.edu) and | will update this document and acknowledge your contribution.

Programs Required-

Global Mapper 12 or ArcMap 10 for digital elevation model (DEM) creation.

ArcMap 10 for cropping map and cross section images.

Photoshop (CS5) for additional image processing.

SketchUp 8 or SketchUp Pro 8 for combining maps and cross sections into a 3D model.
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Materials Required-

A DEM of the area downloaded from http://seamless.usgs.gov/.

A geologic map and cross sections. These can be scanned from paper copies or
downloaded in digital format. | downloaded a sid file of the Rochester Quadrangle,
Vermont from this site: http://ngmdb.usgs.gov/ngmdb/ngm_catalog.ora.html.

Creating the Model-

1. Download a DEM of the area of interest from http://seamless.usgs.gov/. Note that you
must turn off Pop-Up Blocker to navigate the Seamless server.
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a. Exact coordinates can be specified in the Seamless Viewer Downloads area using
the Define Download by Coordinates tool.

Alternatively, Global Mapper or ArcMap can be used to clip a DEM of larger
extent using the coordinates or a polygon feature that corresponds exactly to
the area of interest. The easiest workflow is to open the downloaded zip file of
the DEM in Global Mapper, define the coordinate system, and export the file in
an Elevation Grid Format as a DEM or an USGS DEM. | like to import a bit larger
area and trim it with Global Mapper to the exact coordinates when | export the
DEM. This extra step helps prevent funny edge effects that distort the
topography along the borders of the DEM.
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Prepare the DEM for your model.
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Once downloaded, open the zip file directly in Global Mapper or unzip it and
open it in ArcMap.

Define the projections you wish to use. For Global Mapper: Tools
menu/Configuration/Projection. Unprojected Geographic Coordinate System
(GCS) DEMs will be square for a 7.5’ quadrangle, whereas projected UTM DEMs
will be rectangular and have the same shape as the published map.
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c. | preferto use Global Mapper to prepare the DEM for Google ShetchUp. | export
it in an Elevation Grid Format as a DEM or USGS DEM: File menu/Export
Raster/Image Format.

3. Import the DEM into Google SkechUp.
s
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a. Inthe File menu select Import. You have to use the drop down menu to let

SketchUp know you are importing a DEM, and you can use the Options button to
control the level of detail you want to preserve in the DEM. More points (and




more faces) preserve more topographic information from the DEM, but more
points also create a larger file that can bog down SketchUp during subsequent
steps. | used 10,000 points for the model of the Rochester Quadrangle, which is a
reasonable compromise between topographic detail and file size. The imported
DEM becomes a TIN, or Triangulated Irregular Network. The TIN is a component,
or self-contained entity in SketchUp; when you click on any part of it, the entire
feature is selected. To edit a component, it is necessary to right-click on it and
select Edit Component from the context menu. Typically, the DEM does not look
very promising when it is first imported. There may be a vertical wall along one
edge of the DEM, and the borders of the triangular faces that define the surface
isible.
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Right-click on the DEM component, select Edit Component in the context menu,
select the triangular faces on vertical walls that may exist on the DEM edges with
the Select Tool, and delete them.
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Right-click on the DEM again, select Soften/Smooth Edges, set the Angle
Between Normals to 120 degrees, check both the Smooth Normals and Soften
Coplanar boxes. The DEM should look pretty good now.

4. Prepare the Geologic Map and Cross-sections for your model. Geologic maps and

cross-sections can be scanned from paper copies or downloaded in digital format. The

following site is an excellent place to start looking for material:

http://ngmdb.usgs.gov/ngmdb/ngm catalog.ora.html. There are numerous ways to

prepare the map and cross-sections; the following are the steps | used to create the

map and cross-sections for the Rochester, Vermont Quadrangle.

a.

| downloaded the map and sections as one file in sid format and opened it in
ArcMap.

| set the data frame to Geographic Coordinate System with the same datum as
the map. | georeferenced the map and accompanying sections using the latitude
and longitude values on the corners of the map. Then | changed the data frame
to the same coordinate system | used for the DEM exported from Global
Mapper. It is worthwhile making sure that the map and cross-sections go
through the exact same processes when preparing the images so that no vertical
distortion of sections is unintentionally introduced.

| used the ArcToolsbox/Data Management/Clip Tool to create separate raster
images of the map and each cross section; | eliminated as much ‘collar’ as
possible. In order to use the Clip Tool, you must create a polygon shapefile,
digitize polygons in the precise shape of the map and cross-sections, and use
these polygons to clip the larger image.
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| opened the map and each cross-section file individually in ArcMap and
exported them as png files at 600 dpi resolution.

| opened each file in Photoshop to crop the images and make sure that any area |
wanted to be invisible was transparent. Not all image formats support
transparent edges. Unless you use a format which does, there will be white
boundaries around the edges of the map and cross-sections- not a look you want
because the white edges will obscure the map behind the cross-sections. | also
used Photoshop to make sure the base of each cross-section was as close to
horizontal, i.e. as level, as possible. | used the Rotate Image Tool to adjust
sections as needed.

Drape the geologic map onto the DEM surface.

a.

Use the Camera menu/Standard Views/Top to look straight down at the DEM.
Then use the Camera/Zoom Extents to make the DEM fill your screen. Finally,
Camera/Parallel Projection will make the DEM look like a rectangle with smooth
edges to simplify some of the following steps.

Use the Rectangle Tool to make a rectangle the same shape and size as the DEM,
you may have to make it a bit larger so that the rectangle doesn’t interact with
the DEM component.
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Select the rectangle and use the Move Tool to elevate it directly above the DEM.
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Use File/Import to import the image of the geologic map and place it on the

rectangle. You have to use the drop-down menu to let SketchUp know that you
now want to import an image. Use the cursor to pin the lower left corner of the
image on the lower left corner of the rectangle, and drag the cursor to expand
the image to the edges of the rectangle. If the image is not the same shape as
your rectangle, there is a mismatch in coordinate systems between the DEM and
map. You can use the scale tool to compensate for small discrepancies, but
correcting a large mismatch this way will produce different length scales in the x
and y directions.



e. Orbit the model to select the rectangle below the geologic map image and erase
it- just the rectangle, not the map.

f. Right-click on the map and select Explode.
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g. Right-click on the DEM and select Explode; this may take a while if you used
many points when you imported the DEM.
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h. Use the Window menu to open the Materials window. Select the Eyedropper
tool in the Materials window and click on the geologic map. You should see a



thumbnail of the map in the upper left corner of the Materials window,
indicating that you can use it as a material.
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i. When you move the cursor over the DEM, it will change appearance and indicate

that the Paint Bucket Tool is active. When you click on the DEM with the Paint
Bucket tool you will drape the map over it. This may take a while, so be patient.
You can right-click on the rectangle and select Hide it to hide the upper layer and
admire your DEM with the geologic map draped on it. Don’t erase the rectangle
yet, because we are going to use it in the next step.

6. Create the cross-section planes. There is no one correct way to integrate geologic cross-
sections with the map, although some methods are far easier and more precise than
others. What follows is a detailed description of a method | developed to accommodate
the free version of SketchUp, which eliminates a great deal of potential frustration that
goes along with a strictly manual approach to positioning the sections. Advanced users
of SketchUp Pro have other options available if they make the cross-sections dynamic
components and take advantage of the Component Attributes window.

a. Unhide the rectangle above the DEM if necessary. To be on the safe side, select
it, make a copy using the Move Tool in conjunction with the Control key, move
the copy up or down from the original, and hide the copy in case things go badly.
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Use the Line Tool to trace the cross-sections lines on the flat map above the

Measuremerts

DEM. Make four-sided polygons and connect adjacent cross-section lines along
the edges of the map. Each section line should only connect with one other line;
if there are an odd number of lines, create a polygon containing the odd section
line and three edges of the map.
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Use the Push/Pull Tool to elevate the polygons just created at least as high as the
vertical relief of the cross-sections. There is no need to be precise here; the
vertical planes will exist only long enough to help import the cross-section
images.
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Select ALL planes and lines that are not the vertical planes corresponding to the
cross-section lines, and delete them. (The hidden copy of the map serves as
backup.)

Import the cross-section images one by one, pin them to the lower left corners
of the corresponding vertical section planes, and expand them to fill the
horizontal extent of the section planes.
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When the cross-section images are all imported, select the vertical planes used
as guides, and delete them. The cross-section planes should now be hovering
over the DEM directly above the section lines.



7. Divide the DEM into segments defined by the cross-section lines. At this point, the
DEM is a single entity. If we want to be able to see where the cross-sections and map

meet at the topographic surface, we need to be able to ‘turn off’ portions of the DEM.

a.

Select one of the hovering cross-section planes, and use the Move Tool in
conjunction with the Control button to move a COPY of the cross-section plane.
Move the plane parallel to the Z direction, or Blue Axis until the plane intersects
the DEM. When SketchUp recognizes that you are moving vertically, a floating
box appears with the message “On Blue Axis”. Once this box appears you can
hold down the shift key and restrict movement parallel to the blue axis, or you
can type in a specific value for displacement of the plane. The values you type
appear in the Measurements Box in the lower right-hand corner of the SketchUp
window- you don’t have to click in the box, just start typing and press Enter to
move the plane by the specified amount. Also, you can type in another value to
move the plane a different amount if necessary. | highly recommend this
approach to get used to fine-tuning the placement of planes. At this point,
however, we are not trying to make fine adjustments, just intersect the cross-

section plane with the DEM.
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Use the Scale Tool to make the cross-section plane a bit wider than the DEM.
With the cross-section plane selected, click on the Scale Tool, and grab the
handle on the east side, hold down the control key, and stretch the plane about



the center point to make it longer than the DEM.
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With the section plane copy still selected, go to Edit/Intersect Faces/With Model.
This will divide the DEM into two segments on opposite sides of the cross-
section plane. An easy way to tell if you have succeeded is to click on one
segment with the Select Tool; it should be the only part of the map selected if
you correctly intersected the plane with the DEM, and it should be possible to
hide this segment. Delete the cross-section plane copy.

Repeat this process for all cross-section planes. If you have n cross-sections, you
should have n + 1 DEM segments.

8. Integrate the cross-section planes with the DEM and geologic map.

a.

Select one of the cross-section planes and use the Move Tool to lower it until the
topographic surface of the section matches the topographic surface of the DEM.
It is easier if you Hide one of the DEM segments adjacent to the section plane. |
prefer to use the Measurements Box to move the section-plane by precise
increments to achieve the best fit. If all went well in previous steps, the location
of the section planes should coincide exactly with the cross-section lines on the
geologic map; the topographic surface will almost certainly not match exactly. If
the location of the section planes and lines do not coincide something went
wrong in an earlier step.
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Repeat this step for each cross-section plane. Honestly, it is unlikely that the

topographic surfaces of the section plane and DEM will exactly coincide. At this
point try for the best fit and save the fine tuning for later.

9. Fine tune the integration of the cross-sections with the DEM and geologic map. If the

topographic surfaces of the cross-section plane and DEM match exactly, it is irrefutable

evidence that you have a guardian angel or that you made a deal with the Devil. If all

went well in earlier steps, the vertical relief of the cross-section and DEM should match.

But there are many potential causes for the topographic surfaces of the cross-sections

and DEM to be different. The published geologic cross-sections may have been drawn

with some slight inaccuracies. The geologic map may have used an older base map than
the one used to create the DEM. The resolution of the DEM you downloaded, and the

capacity of your computer to preserve elevation detail may have hindered alignment.

This section describes some relatively easy ways to fix small problems in registry.

a.

If one end of the cross-section plane is clearly lower than the other, the Rotate
Tool can help with alignment. Select the cross-section plane, select the Rotate
Tool, move the compass-shaped tool that appears to the cross section plane to
align it with the plane, hold down the shift key to keep it in the plane, and then
move it to the lower left corner of the plane. Click one to set the axis, move the
cursor along the bottom edge of the section plane and click again to set the
reference line, and rotate the plane in the appropriate direction to correct the
alignment. Once you begin rotating, you can type in a specific value to move the
section plane very small amounts. Think in terms of 0.1° increments. Iterate
between rotations and vertical movement to improve the alignment between
the section plane and the DEM.
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To further improve alignment, you can use the Smoove Tool (as in smooth move)
in the Sandbox Toolbox. (The first time you use the Sandbox Tools you may have
to turn on the Sandbox extension in Window/Preferences/Extensions.) Keep the
DEM on both sides of the section plane visible and use the Smoove tool to make
minor adjustment to the DEM so that it matches the top of the section plane
more closely. You can adjust the radius over which the Smoove tool operates to
optimize efficiency and precision.

10. Use Layers to manage the appearance of your model. At this point, your DEM is divided

into segments defined by the cross-section lines, and the cross-section planes are under

the DEM. It is easy to right-click on any DEM segment and hide it to see the cross-

section below, but this becomes a bit tedious after a while. It is much easier to manage

the appearance of your model using Layers. It also facilitates the creation of animations

of your model, described in the next section. SketchUp uses a brilliant system for

assigning features to layers that involves the Layers and Entity windows.

a.

In the Window menu select Layers. When it opens there is only one layer, Layer
0. Use the + button to create new layers. It is worthwhile assigning each layer a
useful name to keep track of what it contains. Use the cursor to select a feature
that will be assigned to the layer. In the Window menu open Entities. The
selected feature will be listed in the top of the window. Use the drop-down
menu labeled Layers to assign the selected feature to the appropriate layer. To
hide the feature, uncheck the box in the visible column in the Layers window.
Check the layer to make the feature visible again.
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b. Assign each segment of the DEM to its own layer. Cross-sections can each have
their own layers, or be grouped into one layer, depending on how you want your
model to look.

11. Use Shadows to illuminate your model.

12.
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In the Window menu select Shadows. The controls allow you to simulate shadows cast
by the sun for any time of any day of the year! Experiment with the settings to find the
best light to highlight the topography without making the cross-sections too dark to see.
Use Scenes to create animations of your model. Among the many cool features in
SketchUp, Scenes is very cool. It allows you to record an exact perspective of your model
with specific layers visible or invisible. Multiple scenes can be created to organize a
sequential presentation of your model. The family of scenes can also be combined to
produce an animation, and the animation can be exported in a variety of formats.
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Scene 2
Photo: Mone
No Descrption

Scene 3
Photo: NMone
No Description

Scene 4
Photo: None
No Description

Scene 5
Photo: AMone
No Description

No Descrption

Scene 9
Photo: Mone
No Description

a. Inthe Window menu, select Scenes. No scenes will be listed until you create
them. Set up your model with the layers you want to be visible and the desired
perspective. Click the + button to create the first scene. You can label the scenes
and describe them to help you keep track of them.
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b. Create a new scene each time you change perspective or the visibility of a
feature. Each time you create a new scene, a small box with its name appears



just above the SkechUp model window. If you click on one of these boxes your
SketchUp model rotates and pans smoothly to that scene. So, by clicking on the
scenes in order, you can run a guided tour of your model, in this case your DEM
with a draped geologic map and integrated cross-sections.

c. Go to the View menu/Animation/Play to run an animation of your model using
the scenes you created. You can control how the speed at which the animation
runs and the delay between scenes by going to the View
menu/Animations/Settings/Animation.

d. You can export your animations by going to File menu/Export/Animation. There
are several export File Types available on the drop-down menu, and a host of
possible options to control the quality of the exported file with the Options
button.

e.

13. One more trick for viewing your model.
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Here is one trick | discovered recently. If you change the opacity of the map from 100%
to a lower value, even 99% will due, the cross-sections will take precedence over the
map. This means that you can ‘see through’ the map to the cross sections below,
eliminating the need to ‘turn off’ segments of the map. It works fine, but some viewers
may have more trouble processing the map and sections this way than they would if the
an entire segment of the map were invisible. | suspect part of the problem has to do
with missing visual cues to help interpret the image. Still, it makes for an amusing
perspective on the block diagram.



